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１． ｄＴＶソフトウェアおよび本マニュアルについて 

 

１．１ dTVソフトウェアについて 

dTV（diffusion TENSOR Visualizer）は，MR拡散テンソル画像の解析および表示のための処理

を行うソフトウェアであり，マルチチャンネルのボリュームデータを表示する汎用表示ソフトウ

ェア，VOLUME-ONE の機能を拡張する「プラグイン」です．dTVと VOLUME-ONEが協調し

て動作することにより，ROIの設定による特定の神経線維の追跡，拡散テンソル楕円体の表示や，

拡散に関する計測などを行うことができます（図 1.1）．現在の最新バージョンは，dTV.II SR (the 

Second Release)で，VOLUME-ONE 1.72以降のバージョンに対応しています． 

VOLUME-ONE，dTV.II SR ともに非営利かつ非商用の研究を目的とした場合に限り，フリー

ウェアとして利用ができます．VOLUME-ONEや dTV.II SRの著作権，使用条件などに関しては，

以下のウェブサイトをご覧下さい． 

 

VOLUME-ONE: http://www.volume -one.org/ 

dTV:   http://www.ut-radiology.umin.jp/people/masutani/dTV.htm 

 

推奨される実行環境（PC）は使用するデータのサイズによって異なりますが，以下を参考に

してください． 

 

CPU：   Pentium III １GHｚ以上 

RAM：   512M byte以上 

ビデオカード：  ３Dアクセラレータ機能付きビデオカード 

OS：   Windows 98SE以降（NT系を推奨） 

 

これらを満たしていても，モバイル環境など，一部のグラフィックハードウェアでは相性の悪

いものがあり，デスクトップ PCで使用することをおすすめします． 

多くのフリーウェアと同様，dTV はいかなる動作や結果について保証されていません．すな

わち，開発者は，ユーザに対し，いかなる性質の保証責任，その他の義務，責任も負いません． 

また，dTV に使用による一切の損害について，それらの損害の発生，または第三者からの請

求の可能性について通告を受けていた場合であっても，開発者・配布者は，いかなる賠償責任も

負いません． 

また，インストール法や使用法など，dTV に関する質問は一切お受けできません．掲示板を

開設してあるのでそちらをご利用ください．また，掲示板においても，学術的なコミュニケーシ

ョンの慣習に従ってください． 
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図 1.1 VOLUME-ONE 1.72と dTV.II SRによる拡散テンソル解析 

 

また，VOLUME-ONEの機能や他のプラグインと併用することで，より効果的な解析や表示が

可能となります（図 1.2）． 

 

  

図 1.2 VOLUME-ONEの機能による表示効果 

左：VOLUME-ONEの Volume Texture によるボリュームレンダリング像と線維追跡の同時表示 

右：VOLUME-ONEの標準プラグイン（LEGO-RENDER）による表示オブジェクトの追加 
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１．２ 本マニュアルについて 

本マニュアルは，拡散テンソル MR 画像について十分な予備知識のある方を対象としていま

す．よって，拡散テンソル画像とは何か，MPGとは何かなど，拡散テンソル MR 画像の解析に

おいて必要な事項，用語，臨床研究における標準的な使用法などに関しては特に解説しません． 

拡散テンソルMR画像やその解析技法については，「これでわかる拡散MRI（秀潤社）」など，

付録に挙げた参考文献をご覧下さい． 

また，VOLUME-ONEソフトウェアの操作についても，最小限の記述にとどめます．詳しくは，

VOLUME-ONEのマニュアルを参照してください． 
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図 2.1 データ不足の警告ダイアログ 

２． 起動および解析の準備 

 

dTV.II SRによるMR拡散テンソル画像の解析を行うには，下記に説明する手順でソフトウェ

アを起動する必要があります．データの読み込み形式により 2通りの方法があります． 

 

（Ⅰ） dTVから DICOM などの画像データファイルを読み込む 

（Ⅱ） VOLUME-ONEに画像データファイルを読み込み使用する 

 

拡散テンソル画像に含まれる拡散強調像のすべての画像を VOLUME-ONE で観察したい，と

いった特殊な場合を除き，（Ⅰ）の方法を強くお勧めします．（Ⅱ）の方法で VOLUME-ONE に

読み込んだデータも，いったん保存して VOLUME-ONE形式のファイルとして dTVで読み込む

方がメモリ使用量を節約できます．（Ⅰ）の方法でデータを読み込んだ場合はファイルの形式に

よらず，b=0の画像のうち，最初のチャンネルのみが VOLUME-ONEに転送されます．この点は

以前のバージョンと異なります．下記にそれぞれの場合について解説します． 

 

２．１ dTVから画像データファイルを読み込む 

 

（１） VOLUME-ONEの起動 

VOLUME-ONEが起動していないと，dTVは起動しません．また，バージョンが 1.72以降で

あることを確認してください． 

 

（２） dTV.II SRの起動 

VOLUME-ONEの“Tools ->Launch Plug-in...”メニ

ューから，dTV.IISR.exe を指定してください．予め

dTV.IISR.exe を VOLUME-ONEの plug-insのフォル

ダに移動しておくと便利です．このとき，チャンネ

ル数が拡散テンソル画像データセットを構成する

上で不足していることを警告するダイアログ（図

2.1）が表示されますが無視して OKボタンを押し，

次のステップに進みます． 

 

（３） dTV.II SRにおける画像データの読み込み 

dTV.II SRの File メニューの Open コマンドを使用します．サポートされる画像データは，下

記①～③の３種類です．これ以外の形式も，dTVを起動する前に VOLUME-ONEに import し，

補間処理，上下（あるいは左右）反転（ flip）などの前処理の後，チャンネル分割された

VOLUME-ONEファイルとして保存することで，dTVから読み込み，使用することができます． 
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図 2.2 MPG 設定の確認ダイアログ 

① DICOM 画像 

Fileメニューの Open DICOM directory コマンドでディレクトリを指定すると，自動的に補間

処理を開始し，最初の１チャンネル分のデータが VOLUME-ONE へ転送されます．この処理

は 1分程度かかる場合があります．DICOM データについては，少なくとも以下の条件を満た

す必要があります． 

 

‐ あるフォルダに必要なすべてのDICOMデータのみが収められている 

‐ 各 DICOM データファイルのイメージナンバが１から始まる連番である 

‐ 順序がMPG毎になっている（スライス毎ではない） 

‐ FOVあるいは Pixel Spacingの情報がヘッダに含まれている 

 

※この他にも DICOM データとして本来は満たしておくべき条件がありますが，データによっ

ては満たしていない場合があります．これらを含めて何らかの理由によりDICOMが正しく読

めない場合は，他のソフト（grosaDICOM，MRIcro など）で RAW 形式に変換し，必要に応じ

て補間，チャンネル分割などの処理をVOLUME-ONE で行ってください． 

 

② DTIファイル（dTV）形式 

DTI ファイルは，dTV 独自のファイル保存形式で，画像データの他にボクセル実寸や MPG

データなどを含んでおり，この形式で保存しておくと，読み込み時のMPG設定が必要ありま

せん． 

 

③ VOLUME-ONEファイル 

解像度が等方的になっている（補関されている）ことが必要です．また，VOLUME-ONEに

おける上下反転などの前処理を行うことで，MPG の座方軸が相対的に変化している場合があ

ります．その場合，MPGファイルでの記述にて修正してください． 

 

（４） チャンネル数確認ダイアログの表示 

データが正常に読み込まれると，チャンネル数, 

MPG数などの確認ダイアログ（図 2.2）が表示さ

れるので，確認してください． 

また，デフォルトのMPGベクトルデータ（６

～１２９方向に対応）がコンソールウィンドウ

（図 2.3）に表示されるので，内容を確認して正

しくない場合は次のステップ（５）を行ってくだ

さい． 
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図 2.3 コンソールウィンドウに表示されたMPGデータ 

 

（５） チャンネル数の再設定およびMPGファイルの読み込み（必要時のみ） 

（４）で表示された内容が，実際のデータの設定と異なる場合は，ここで修正してください．

修正の方法としては，メニューより数を直接入力するか，ファイルを作成して読み込む方法があ

ります．メニューでは，拡散テンソル画像を構成する総チャンネル数，b=0画像のチャンネル数，

共通の b値が入力できます．これらを入力した後，コンソールウィンドウ（図 2.3）に表示され

る設定を確認し，もし異なる設定ならばファイルを作成します． 

ファイルによる設定では，複数のｂ値の使用や，MPG の回転の記述など，より自由度の高い設

定が可能です．付録にサンプルファイルの内容を示します．このファイルは，ウェブサイトから

もダウンロードできます． 
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２．２ VOLUME-ONEに画像データファイルを読み込み使用する 

 

（１） VOLUME-ONEの起動 

VOLUME-ONEが起動していないと，dTVは起動しません．また，バージョンが 1.72以降で

あることを確認してください． 

 

（２） VOLUME-ONEにおける画像データの読み込み 

VOLUME-ONE形式，RAWフォーマットなどの画像を読み込み，補間，上下（あるいは左右）

反転，チャンネル分割処理などを行い，準備します． 

 

（３） dTV.II SRの起動 

VOLUME-ONEの Tools メニューの Launch Plug-in...から dTV.IISR.exe を指定し，起動します．

データが全て dTV.II SRに転送されるので時間がかかることがあります．また，メモリの確保に

失敗すると強制終了することがあります． 

これ以降はⅠの（４）以降と同様です．ただし，チャンネル数が拡散テンソル画像データセッ

トを構成する上で不足する場合（チャンネル数が６以下），データ不足のダイアログが表示され

ます（図 2.1）． 
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図 3.2 ROI オブジェクトリスト 

３． 解析オブジェクトおよび ROIオブジェクト 

 

３．１ 解析オブジェクト 

dTV.II SRでは，３つのタイプの解析（線維追跡：

fiber tracking／拡散プロファイル表示： diffusion 

profile／ボクセル統計解析：Voxel Statistics）が実行可

能です．これらの解析の実行においては，解析の設

定および表示データを，解析オブジェクト（study 

object）として保持することにより，必要に応じて設

定を変更して解析をやり直したり，必要な解析オブ

ジェクトの結果のみを表示したり，といった自由度

の高い操作が可能です． 

起動時には，デフォルト設定でこれらのオブジェ

クトが一つずつ作成され，リストに表示されていま

す（図 3.1）．必要に応じて解析オブジェクトの追加

や，複製，消去が可能です． 

 

３．２ ROIオブジェクト 

ＲＯＩオブジェクトは各解析オブジェクトで使用

されるもので，それぞれの解析オブジェクトが独自

に設定するものと，ROI エディタで作成された共有

可能なものの２種類があります． 

本マニュアルでは，前者を各解析オブジェクトに

固有で他のオブジェクトが使用できない意味でロー

カル ROI，後者を複数の解析オブジェクトで共有で

きる意味で，グローバルＲＯＩと呼びます．ローカ

ルＲＯＩとしては，球形ＲＯＩ，自由曲線ＲＯＩの

２種類があり，グローバルＲＯＩでは，これらに加

えてボクセルグループＲＯＩが利用できます． 

グローバル ROIオブジェクトは，次節で解説され

る ROI エディタで作成するか，各解析オブジェクト

で設定したローカル ROI を ROIエディタへ export（実際には複製されます）することで作成で

きます．起動時には，グローバル ROI オブジェクトは各種一つずつ作成され，リストに表示さ

れています（図 3.2）． 

図 3.1 解析オブジェクトリスト 
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図 4.1 dTV.II SR の GUI 

（解析パフォーマ：線維追跡オブジェクト選択時） 

赤枠：パネル切り替えタブ 

緑枠：メッセージ表示領域 

４． GUI概要 

 

４．１ ＧＵＩ全体 

dTV.II SRの GUI （Graphical User Interface）は，最上部にファイル操作などのプルダウンメニ

ューがあり，その下に，以下の３つのパネルが重なって表示されています． 

 

・解析パフォーマ （Study performer） 

・ＲＯＩエディタ （ROI editor） 

・ユーティリティ （Utility） 

 

タブ部分をクリックしてこれらのパネルを切

り替えます（図 4.1 赤枠）．それぞれのパネルで

は，選択された解析オブジェクトや ROI オブジ

ェクトに応じて，自動的にその設定パネルが切り

替わります．各オブジェクトの設定パネルでは，

さらに目的に応じて様々なパネルが用意されて

いるので，必要に応じて切り替えます． 

各オブジェクトのパネルの詳細な使用法やメ

ニューにある共通な処理については次節以降の

解説を参照してください． 

また，最下部には，後に述べるリアルタイム計

測機能などで共通に使用されるテキスト表示エ

リアがあります（図 4.1緑枠）． 

 

注意すべき点は，プルダウンメニューなどに割

り当てられている，キーボードショートカットで

ず．VOLUME-ONEと dTV.II SRは，キーボード

ショートカットをそれぞれ独自に割り当ててい

ますので，使いたい機能のソフトウェアのウィン

ドウをアクティブにしてから，キーボードショー

トカットを使用するようにしてください．但し，

チャンネルの変更など，共通しているものもある

ので注意してください． 
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図 4.2 ROI パレット 

４．２ 共通 GUI 

ここでは，複数のパネルに共通して使用されている GUI要素として，ROIパレットと ROIセ

レクタについて解説します． 

 

（１） ROIパレット 

ROI パレットは，各解析オブジェクトの設定や

ROI エディタで共通に使用されるインターフェイ

スであり，図 4.2に示すように断面画像表示パネル

と，その下に，拡大縮小，チャンネル変更，グレ

ースケール変更，VOLUME-ONE のカーソルとの

位置同期ボタンと，断面タイプの選択メニューか

ら成ります． 

断面画像表示パネル内におけるマウスでの操作

で，球形 ROI の半径を変更したり，自由曲線 ROI

を直接描画したりします．使用できる ROIのタイ

プは，解析オブジェクトや ROI オブジェクトによ

って異なります．また，マウスとキーボードの同

時操作により，位置の移動，グレースケールの変

更，閉曲線の自動キャプチャなどが可能です．操

作を下記の表にまとめます． 

 

 マウス左ボタン マウス中ボタン マウス右ボタン 

通常  

 

球形 ROIの半径設定／フリーハンド形状の描画 

Ctrlキー使用時  

 

表示面内での 

位置の移動 

表示面に垂直な方向

への位置変更 

グレースケール変更 

表 ROIパレットでのマウス操作 

 

ROI設定パネルの画像のグレースケールは，マウスのドラッグ方向の上下で明るさ（ level）の

変更，左右でコントラスト（width）の変更ができます． 

フリーハンド ROI形状タイプを使用中に，グレースケールの調整で 2値化状態となった場合，

あるいは VOLUME-ONEとの同期時に VOLUME-ONE側で 2値化状態になった場合には，中心

位置を示す４本の線が白色となり，自動キャプチャ機能が使用できます(図 4.3)．高い信号の場

合は領域内で，低い場合は領域のすぐ左側をクリックすると ROI が自動的にキャプチャされま

す． 

断面のタイプは，Axial，Sagittal，Coronal，Oblique，Sphericalの４種類です．Oblique断面は，
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VOLUME-ONE との同期中に，VOLUME-ONE の oblique 断面と向き，位置が一致します．

VOLUME-ONEの oblique断面は，カーソル位置や３Dの観察方向に依存します． 

Spherical 面は，ボリュームデータの中心をその中心とする球面を外側から観察したものです

（図 4.4）．脳表付近の ROIを球面状に決定するとき使用します． 

この時のマウス操作は，他の平面設定と同じように，マウスの左ボタンで面内の移動，すなわ

ち同じ半径の球面上での緯度／経度を変更します．中ボタンは，球面に垂直な方向，すなわち球

面を形成する際の半径を変更します． 

   

図 4.3 自動 ROIキャプチャ 

左：上下左右の 4本の線が白色になっている 2値化状態で対象となる領域をクリック 

右：キャプチャされた ROI 

  

図 4.4  Spherical面の設定 

左：表示画面，右：設定される面とその変更 
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図 4.5 ROI リスト 

（２）  ROIリスト 

ROIリストは，解析オブジェクト（のみ）の設

定パネルで共通に使用されるものです（図 4.5）．

これは，ROI エディタ内に含まれる ROI のリス

トを表示したもので，ROIエディタの最上部にあ

るリストと似ていますが，状態や可視／不可視の

項目が表示されないことと，複数の項目が選択

できる点が異なります． 

解析において，単一の目的（例えば線維追跡の

Seed ROI）に，複数個のＲＯＩを割り当てたいと

き，このＲＯＩリストを使用してグローバルＲＯ

Ｉを選択します．使用法は，リストの中から選択

する項目を１つ以上指定するだけです． 

ＲＯＩエディタで変更された内容や，ＲＯＩの

消去などは，ＲＯＩリストにすぐ反映されます． 
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図 5.1 解析オブジェクトメニュー 

５． 解析パフォーマ使用法 

 

５．１ 解析オブジェクトリストと関連 GUI 

作成されている解析オブジェクトは，図 3.1に示すリスト内に表示され，オブジェクトのタイ

プや名称，状態が表示されています．また，選択されている解析オブジェクト（常に１つだけ）

は色が反転して表示されています． 

リストの下には，名称の変更や表示／非表示の切り替えのためのインターフェイスと解析オブ

ジェクトに関する処理をまとめたメニューがあります．  

 

５．２ 解析オブジェクトメニュー 

解析オブジェクトメニューでは，新しい解析オ

ブジェクトの作成やリストで選択されているオ

ブジェクトの複製，消去が可能です． 

この他に，表示／非表示の一括制御，よく使用

するプリセットラベルの適用やメモの保存に関

するコマンドや後に述べるメモの保存など，解析

オブジェクトの各種操作に関するコマンドが使

用できます（図 5.１）． 

 

５．３ 各解析の実行方法<１>： 線維追跡 

Seed（追跡開始）ROIに加えて，必要に応じて Target（目標）ROI，Avoidance（忌避）ROIを

設定することにより，描出したい線維構造を限定することができます．また，追跡の終了条件，

表示設定などが，それぞれのオブジェクトに割り当てられているので，後で変更して再解析する

ことで容易に結果の比較ができます．以下に，基本的な手順を示します． 

 

（１） 線維追跡オブジェクトの選択あるいは作成  

 起動時には，既にデフォルトとして作成されている“Fiber Tracking 1”を選択するか，あるい

は解析オブジェクトメニューの中から“New->Fiber tracking”を選択して，作成します． 

 

（２） Seed ROIの設定  

Seed ROIは，“Seed”タブをクリックして表示されるROIパレットを使うことにより，ローカ

ル ROI として球形あるいは自由曲線の ROI を設定できます．また，リストに表示されたグロー

バル ROIの中から球形 ROI，自由曲線 ROI，ボクセルグループ ROIを選択して使用することが

できます（複数可）．これらの切り替えは ROIパレット上部のボタンで，Spherical（球形），Freehand

（自由曲線），Listed（リスト内）の中から指定します． 
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図 5.3 表示設定 

図 5.2 追跡設定 

（３） Target ROI／Avoidance ROIの設定  

これらの ROIも Seedと同様に設定できます．これら

の ROIは，デフォルトでは不使用となっていますので，

“Use”ボタンをクリックして，ROIパレットをアクテ

ィブにする必要があります． 

 

（３） 追跡設定  

追跡設定は，Seed ROI における開始点発生密度，追

跡方法，使用／不使用を含めた追跡終了条件のパラメ

ータからなります（図 5.2）．“Setting”タブおよび

“Tracking”タブをクリックして表示します．追跡方法

は，基本となる第一固有ベクトル方向（basic）と，異

方性に応じた方向の補正を含めた方法（Advanced）の

２つから選択できます．異方性に応じた方向の補正の

方法は，付録の参考文献[4]を参照してください． 

 

（４） 表示設定  

表示設定は，結果の表示のプリミティブとしてヘア

ライン／チューブの選択，追跡軌跡の色づけ方法が選

択できます．“Setting”タブおよび“Display”タブをク

リックして表示します． 

色づけ方法は，異方性およびその特性に応じた色づ

け(anisotropy coding)，Seed からの距離による色づけ

(distance coding)，追跡方向による色づけ(directional 

coding)，軌跡ごとの色づけ(unique color)，単色の色づ

け(uniform color)が可能です（図 5.3）．単色の切り替え

は，色が表示されている領域（図 5.3 の赤色の矩形）

をクリックすると設定ダイアログが表示して行ってく

ださい． 

 

（５） 解析の実行と結果の表示 

上記の各種設定が完了したら，“Analyze and Display”ボタンを押して線維追跡を実行します．

線維追跡の軌跡が VOLUME-ONE に，Seed 点数などの情報が dTV.II SR の線維追跡パネルの

“Summary”パネルに表示されます．“Summary”パネルには，自由にメモなどが追加できます．  

追加したメモを記録したい場合は，“Study->Summary string->Record current”コマンドを使

用してください．これを行わないと，他の解析オブジェクトに切り替えたときに失われます．  
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図 5.4 拡散プロファイルの表示設定 

５．４ 各解析の実行方法<２>： 拡散プロファイル 

この解析では，設定したＲＯＩ内部に拡散プロファイルやその楕円体近似を，３次元形状にて

表示するもので，線維追跡では不可能な，各点ごとの拡散の詳細な状況を表示・観察することが

できます．下記に手順を示します． 

 

（１） 拡散プロファイルオブジェクトの選択あるいは作成 

 起動時には，既にデフォルトとして作成されている“Diffusion Profile 1”を選択するか，ある

いは解析オブジェクトメニューの中から“New-> Diffusion profile”を選択して，作成します． 

 

（２） ROIの設定 

拡散プロファイル表示の範囲を指定する ROIは，ローカル ROIとして球形ROIあるいは自由

曲線 ROI，またグローバルＲＯＩとして ROI エディタで作成した球形 ROI，自由曲線 ROI，ボ

クセルグループ ROI をリストから選択できます．また，VOLUME-ONEで設定した箱型ＶＯＩ

（Volume Of Interest）も使用でき，これがデフォルトとなっています．上記のタイプのローカル

ROIを使用するには，“Box VOI”ボタンをクリックして，ROIパレットをアクティブにします．  

 

（３） 表示設定 

表示設定は，プロファイル形状を表示する条件，お

よびプロファイルのタイプ（テンソル楕円体：tensor 

ellipsoid／包絡面：envelop surface／星型：star）や，Ｒ

ＯＩ内で発生させるプロファイル形状の密度，色づけ

方法（異方性：anosotropy／方向：direction），異方性強

調（anisotropy emphasis）の使用／不使用です（図 5.4）．

包絡面の表示にはは，多くの計算時間を必要とします

ので，小さなＲＯＩで計算時間を確認してから，お試

しください． 

 

（５） 解析の実行と結果の表示 

上記の各種設定が完了したら，“Analyze and Display”

ボタンを押して実行します．プロファイル形状が

VOLUME-ONEに，表示プロファイル数などの情報が，

dTV.II SR拡散プロファイル表示パネルの“Summary”

パネルに表示されます．“Summary”パネルには，自由にメモなどが追加できます． 
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図 5.5 ボクセル統計解析結果 

５．５ 各解析の実行方法<３>： ボクセル統計解析 

この解析では，設定したＲＯＩ内部のボクセルごとの拡散パラメータを集計し，その統計情報

を表示するものです． 

 

（１） ボクセル統計解析オブジェクトの選択あるいは作成 

 起動時には，既にデフォルトとして作成されている“Voxel Statistics 1”を選択するか，あるい

は解析オブジェクトメニューの中から“New“Voxel statistics”を選択して，作成します． 

 

（２） ROIの設定 

ボクセル統計解析の範囲を指定する ROIは，ローカルROIとして球形 ROIあるいは自由曲線

ROI，またグローバルＲＯＩとして ROIエディタで作成した球形 ROI，自由曲線 ROI，ボクセル

グループ ROIをリストから選択できます．また，VOLUME-ONEで設定した箱型ＶＯＩ（ Volume 

Of Interest）も使用でき，これがデフォルトとなっています．上記のタイプのＲＯＩを使用する

には，“Box VOI”ボタンをクリックして，ROIパレットをアクティブにします． 

 

（３） 解析の実行と結果の表示 

上記の各種設定が完了したら，“Analyze and Display”

ボ タ ン を 押 し て 実 行 し ま す ． ROI 形 状 が

VOLUME-ONE にワイヤフレームとして表示され，

ボクセル統計解析の結果が dTV.II SRのボクセル統計

解析パネルの“Summary”パネルに表示されます．

“Summary”パネルには，自由にメモなどが追加でき

ます． 

表示内容は，ROI内の解析に有効なボクセル数（拡

散テンソルが正常に計算されたボクセル数）と

So(b=0)画像の信号値，FA 値，ADC 値，３つのテン

ソル固有値の各最大，最小，平均，標準偏差です． 

 

５．６ ローカル ROIの export 

各解析オブジェクトのために設定したローカル ROIを，他の解析オブジェクトで使用したり，

加工したりするために，ROIエディタに export できます．対象となる球形，または自由曲線 ROI

を設定した ROIパレットが表示されている状態で，“Special->ROI palette frame ->Export ROI to 

Editor”を使用してください．GUIが ROIエディタに自動的に変わり，編集可能な状態になりま

す． 
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図 5.6 解析パフォーマによる結果例（線維追跡） 

左上：脳表に ROI設定 

右上：追跡結果（distance coding） 

左下：追跡結果の他の色づけ（unique color） 

右下：同（anisotropic codingと directional coding） 
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図 5.7 解析パフォーマによる結果例（拡散プロファイルとボクセル統計解析） 

左上：拡散プロファイルの包絡面表示（directional coding） 

右上：同星型表示 

左下：線維追跡結果のボクセルグループ ROI化（その他の機能参照）  

右下：同ボクセル統計解析結果 
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図 6.3 自由曲線 ROI設定 図 6.2 球形 ROI設定 

図 6.1 ROI オブジェクトメニュー 

６． ＲＯＩエディタ使用法 

 

ＲＯＩエディタでは，複数の解析オブジェク

トで共有可能なグローバルＲＯＩの作成がで

きます．また，解析オブジェクトのローカル

ROIをＲＯＩエディタに export することで，複

数の解析オブジェクトで ROI を共有すること

ができます．作成した ROIは，図 3.2のように

ROI オブジェクトのリストとして表示されて

います． 

リストの下には，名称の変更や表示／非表示

の 切 り 替 え ， ま た エ デ ィ タ 使 用 中 に

VOLUME-ONE で表示される色の変更のため

のインターフェイスと ROI オブジェクトに関

する処理をまとめたメニューがあります． 

変更を加えたい ROIをリストから選択知ることにより，自動的に各タイプの ROI の設定パネ

ルが表示されます（図 6.2～6.4）．また，ROI オブジェクトメニューでは，ROI オブジェクトの

新規作成や p，複製や消去，表示に関するの設定などの変更が可能です． 

 

６．１ 球形ＲＯＩ 

ＲＯＩパレットを使用してマウスの操作で球の半径や中心位置を変えられる他，数値入力も可

能です（図 6.2）．表示される座標や半径の単位はボクセルです．座標や半径の入力はすべてボタ

ンで行います．左ボタンで最小ステップ（±0.1），中ボタンで整数ステップ（±1.0），右ボタン

で両端まで移動します． 

 

６．２ 自由曲線ＲＯＩ 

ＲＯＩパレット内で，マウ

スを使って自由曲線を描き，

ＲＯＩとします．また，面内

す な わ ち ２ 次 元 の 膨 張

（ dilation）あるいは収縮

（erosion）処理が可能です

（図 6.3）． 

収縮により閉曲線で囲ま

れた領域が分割されてしま

うような場合は，分割された
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もののどれか１つのみが残されます． 

 

６．３ ボクセルグループＲＯＩ 

自由曲線ＲＯＩのパネルと同様，ＲＯＩパレット内に自由曲線が描け，そのまま使用すると自

由曲線ＲＯＩとほぼ同等ですが，データはボクセルのグループに変換され，さ らに３次元的に拡

張することができます（図 6.4 左上）．拡張の条件としては，拡張回数の他，ROI パレットに表

示されている画像（グレーのみ）の単一の信号のしきい値（最大，最小）と，テンソル情報（主

方向の変化，異方性など）の 2種類が可能で，ボタンによって切り替えます（図 6.4 右上）．ま

た，形状の単純な膨張や収縮も可能です． 

平面や曲面上の 2次元のＲＯＩだけでなく，3次元的な広がりをもつＲＯＩを使用することで，

ボクセル統計解析などで，より精度の高い計測が可能です． 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 6.4 ボクセルグループROI設定 

左上：拡張の開始領域，右上：拡張条件 

下段：VOLUME-ONEで表示される3 次元ＲＯＩオブジェクト 

（左：拡張前，右：拡張後） 
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７． その他の機能 

 

７．１ 計算画像作成 

“Special->Add computational channels”コマンドで，カラーFA 画像（FA画像に，テンソル主

方向の XYZ 成分をボクセル色の RGB 成分に変換した色成分を重畳したもの），FA 画像，ADC

画像，等方拡散画像が作成され，VOLUME-ONEに転送されます．このとき，ボクセル値は精度

を保持しながら整数となるよう，FAが 100倍，ADCが 100,000倍されています．画像のサイズ

によっては数分を要することがあります．計算過程の進行状況は，コンソールウィンドウに表示

されます． 

 

７．２ 線維追跡結果のボクセル化 

線維追跡の結果を観察する場合，3次元オブジェクトよりも 2次元の断面ごとに観察した方が

適している場合があります．線維追跡結果のボクセル化は，線データである追跡結果を元画像デ

ータと同じ解像度の画像データへの変換を行うものです． 

“Special->Voxelize visible trackline as”メニューのコマンドを使用してください．出力形式と

しては，カラーのボリュームデータ，グレーのボリュームデータ，ボクセルグループ ROIです．

もし，ボクセル化したくない線維追跡の解析オブジェクトがあれば，解析オブジェクトリストの

したのボタンで不可視にしてください．線維追跡以外の解析オブジェクトは関係ありません． 

ボリュームデータが出力形式の場合，ROIパレットが表示されている状態で，VOLUME-ONE

の選択範囲の画像データをブレンドすることができます．但し，対象となる画像は，ｂ＝０画像

や追加した T1強調像など，符号付１６ビットデータに限ります． 

ボクセルグループ ROIへの変換では，追跡結果をボクセルグループ ROIにすることで，描出

線維束が通過するボクセル群の統計解析や拡散プロファイル表示などに適用可能です．また，そ

のボクセルＲＯＩを利用して線維追跡を行なうこともできます． 

 

７．３ 線維追跡結果の詳細出力（ダンプ） 

 線維追跡結果の詳細なデータ，すなわち追跡線上の各点の座標やその点での拡散パラメータな

どを解析に利用したい場合にこの機能を使用します．“Analyze and Display”ボタンを押す代わり

に，解析オブジェクトリストの右下にあるメニューの“Study->Special->Analyze and dump result”

コマンドを使用してください．出力結果はテキストファイルです． 

 

７．４ リアルタイム計測機能 

Specialメニューの“Start realtime analysis”コマンドを選択すると，VOLUME-ONEのカーソル

位置での FA 値，ADC 値，テンソルの固有値がメッセージ表示領域に表示されます．この機能

は Analyze and Displayボタンで他の処理を実行すると解除されます． 
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７．５ ROI形状の VOLUME-ONEでの表示 

“Special->Setting->ROIｓ”メニューで，ROI形状の VOLUME-ONEでの表示・非表示の切り

替えが可能です．ROI形状を変更後は再度，表示を指定することで更新されます． 

表示される ROI は，モードによって異なります．解析パフォーマ使用中は，選択されている

解析オブジェクトの ROIが表示され，ROIエディタ使用中は表示設定が“visible”になっている

ROIオブジェクトがすべて表示されます． 

 

７．６ 解析の作業状態の保存・復帰 

 “File->Save work data”で作業の途中の状態を保存，“File->Open work data”で復帰します．但

し，保存される内容は解析の設定，および結果のサマリのみです．すなわち，ファイル容量を小

さくするため，解析結果、および表示オブジェクトは保存されません．保存前の状態に完全に復

帰するには，各解析オブジェクトに対して解析を再実行してください．“Study->Special->Analyze 

all studies”などを使用すると便利です。 
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MPGファイルフォーマットの例  

 

以下に，ＭＰＧファイルのサンプルを示します． 

＝＝＝＝＝＝＝＝このラインを除き，これより下がＭＰＧファイルの内容＝＝＝＝＝＝＝＝＝＝  

#dTV-II MPG description file (not used in earlier dTV) 

1.0 0.0 0.0 

0.0 1.0 0.0 

7 

1 

0.0  0.000000  0.000000  0.000000 

1000.0  0.707000  0.000000  0.707000 

1000.0 -0.707000  0.000000  0.707000 

1000.0  0.000000  0.707000  0.707000 

1000.0  0.000000  0.707000 -0.707000 

1000.0  0.707000  0.707000  0.000000 

1000.0 -0.707000  0.707000  0.000000 

＝＝＝＝＝＝＝＝このラインを除き，これより上がＭＰＧファイルの内容＝＝＝＝＝＝＝＝＝＝  

 

最初の行は，ＩＤの文字列です．このままコピーしてください． 

２，３行目は，画像の軸を示すベクトルです．DICOM に含まれる Image Orientationと同じ意

味です．ＭＰＧが画像の軸でなく，スキャナ座標系で記述されているときにここに，その向きを

記述することでＭＰＧを回転できます． 
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４，５行目は，それぞれ総ＤＴＩチャンネル数，ｂ＝０画像チャンネル数です．総ＤＴＩチャ

ンネル数は，計算画像の付加後など，実際のボリュームデータのチャンネル数より小さい場合が

あります． 

６行目以降が，ＭＰＧベクトルの方向とそれに対応するＭＰＧの大きさです．行の先頭が，Ｍ

ＰＧの強度（b 値）で，続く３つの数字がベクトルのｘｙｚ成分です．各ＭＰＧの大きさと向き

は，方向が正規化されたベクトルで記述し，合成後の大きさをｂ値としてください． 

 

 


